


Source: Percentage points calculated using Minitab software.

a

ta

  df t.100 t.050 t.025 t.010 t.005 df

    1 3.078 6.314 12.706 31.821 63.657 1
    2 1.886 2.920   4.303   6.965   9.925 2
    3 1.638 2.353   3.182   4.541   5.841 3
    4 1.533 2.132   2.776   3.747   4.604 4
    5 1.476 2.015   2.571   3.365   4.032 5

    6 1.440 1.943   2.447   3.143   3.707 6
    7 1.415 1.895   2.365   2.998   3.499 7
    8 1.397 1.860   2.306   2.896   3.355 8
    9 1.383 1.833   2.262   2.821   3.250 9
  10 1.372 1.812   2.228   2.764   3.169 10

  11 1.363 1.796   2.201   2.718   3.106 11
  12 1.356 1.782   2.179   2.681   3.055 12
  13 1.350 1.771   2.160   2.650   3.012 13
  14 1.345 1.761   2.145   2.624   2.977 14
  15 1.341 1.753   2.131   2.602   2.947 15

  16 1.337 1.746   2.120   2.583   2.921 16
  17 1.333 1.740   2.110   2.567   2.898 17
  18 1.330 1.734   2.101   2.552   2.878 18
  19 1.328 1.729   2.093   2.539   2.861 19
  20 1.325 1.725   2.086   2.528   2.845 20

  21 1.323 1.721   2.080   2.518   2.831 21
  22 1.321 1.717   2.074   2.508   2.819 22
  23 1.319 1.714   2.069   2.500   2.807 23
  24 1.318 1.711   2.064   2.492   2.797 24
  25 1.316 1.708   2.060   2.485   2.787 25

  26 1.315 1.706   2.056   2.479   2.779 26
  27 1.314 1.703   2.052   2.473   2.771 27
  28 1.313 1.701   2.048   2.467   2.763 28
  29 1.311 1.699   2.045   2.462   2.756 29
  30 1.310 1.697   2.042   2.457   2.750 30

  31 1.309 1.696   2.040   2.453   2.744 31
  32 1.309 1.694   2.037   2.449   2.738 32
  33 1.308 1.692   2.035   2.445   2.733 33
  34 1.307 1.691   2.032   2.441   2.728 34
  35 1.306 1.690   2.030   2.438   2.724 35

  36 1.306 1.688   2.028   2.434   2.719 36
  37 1.305 1.687   2.026   2.431   2.715 37
  38 1.304 1.686   2.024   2.429   2.712 38
  39 1.304 1.685   2.023   2.426   2.708 39
  40 1.303 1.684   2.021   2.423   2.704 40

  45 1.301 1.679   2.014   2.412   2.690 45
  50 1.299 1.676   2.009   2.403   2.678 50
  55 1.297 1.673   2.004   2.396   2.668 55
  60 1.296 1.671   2.000   2.390   2.660 60
  65 1.295 1.669   1.997   2.385   2.654 65

  70 1.294 1.667   1.994   2.381   2.648 70
  80 1.292 1.664   1.990   2.374   2.639 80
  90 1.291 1.662   1.987   2.368   2.632 90

100 1.290 1.660   1.984   2.364   2.626 100
200 1.286 1.653   1.972   2.345   2.601 200

300 1.284 1.650   1.968   2.339   2.592 300
400 1.284 1.649   1.966   2.336   2.588 400
500 1.283 1.648   1.965   2.334   2.586 500
inf. 1.282 1.645 1.96   2.326   2.576 inf.

■ Table 4 Critical Values of t, pages 692–963
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Every time you pick up a newspaper or a magazine, watch TV, or scroll through  Facebook, 
you encounter statistics. Every time you fill out a questionnaire, register at an online 
 website, or pass your grocery rewards card through an electronic scanner, your personal 
information becomes part of a database containing your personal statistical information. 
You can’t avoid it! In this digital age, data collection and analysis are part of our day-to-day 
activities. If you want to be an educated consumer and citizen, you need to understand how 
statistics are used and misused in our daily lives.

This international metric version is designed for classrooms and students outside of 
the United States. The units of measurement used in selected examples and exercises have 
been changed from U.S. Customary units to metric units. We did not update problems that 
are specific to U.S. Customary units, such as passing yards in football or data  related to 
specific publications.

the Secret to our Success
The first college course in introductory statistics that we ever took used Introduction to 
Probability and Statistics by William Mendenhall. Since that time, this text—currently in 
the fifteenth edition—has helped generations of students understand what statistics is all 
about and how it can be used as a tool in their particular area of application. The secret to 
the success of Introduction to Probability and Statistics is its ability to blend the old with 
the new. With each revision we try to build on the strong points of previous editions, and 
to look for new ways to motivate, encourage, and interest students using new technologies.

Hallmark Features of the Fifteenth Edition
The fifteenth edition keeps the traditional outline for the coverage of descriptive and 
 inferential statistics used in previous editions. This revision maintains the straightforward 
presentation of the fourteenth edition. We have continued to simplify the language in order to 
make the text more readable—without sacrificing the statistical integrity of the presentation. 
We want students to understand how to apply statistical procedures, and also to understand

• how to meaningfully describe real sets of data

• how to explain the results of statistical tests in a practical way

• how to tell whether the assumptions behind statistical tests are valid

• what to do when these assumptions have been violated

Exercises
As with all previous editions, the variety and number of real applications in the exercise 
sets is a major strength of this edition. We have revised the exercise sets to provide new and 

Preface
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interesting real-world situations and real data sets, many of which are drawn from current 
periodicals and journals. The fifteenth edition contains over 1900 exercises, many of which 
are new to this edition. Exercises are graduated in level of difficulty; some, involving only 
basic techniques, can be solved by almost all students, while others, involving practical 
applications and interpretation of results, will challenge students to use more sophisticated 
statistical reasoning and understanding. Exercises have been rearranged to provide a more 
even distribution of exercises within each chapter and a new numbering system has been 
introduced, so that numbering begins again with each new section.

organization and Coverage
We believe that Chapters 1 through 10—with the possible exception of Chapter 3—should 
be covered in the order presented. The remaining chapters can be covered in any order. 
The analysis of variance chapter precedes the regression chapter, so that the instructor can 
present the analysis of variance as part of a regression analysis. Thus, the most effective 
presentation would order these three chapters as well.

Chapters 1–3 present descriptive data analysis for both one and two variables, using 
MINITAB 18, Microsoft Excel 2016®, and TI-83/84 Plus graphics. Chapter 4 includes a full 
presentation of probability. The last section of Chapter 4 in the fourteenth edition of the 
text, “Discrete Random Variables and Their Probability Distributions” has been moved to 
become the first section in Chapter 5. As in the fourteenth edition, the chapters on analysis 
of variance and linear regression include both calculational formulas and computer print-
outs in the basic text presentation. These chapters can be used with equal ease by instructors 
who wish to use the  “hands-on” computational approach to linear regression and ANOVA 
and by those who choose to  focus on the interpretation of computer-generated statistical 
printouts. This edition includes  expanded coverage of the uniform and exponential distri-
butions in Chapter 5 and normal probability plots for assessing normality in Chapter 7, 
in  addition to an expanded t-table (Table 4 in  Appendix I). New topics in Chapter 13  include 
best subsets regression procedures and binary logistic regression.

One important feature in the hypothesis testing chapters involves the emphasis on 
p-values and their use in judging statistical significance. With the advent of computer- 
generated p-values, these probabilities have become essential in reporting the results of a
statistical analysis. As such, the observed value of the test statistic and its p-value are pre-
sented together at the outset of our discussion of statistical hypothesis testing as equivalent
tools for decision-making. Statistical significance is defined in terms of preassigned values
of , and the p-value approach is presented as an alternative to the critical value approach
for testing a statistical hypothesis. Examples are presented using both the p-value and
 critical value approaches to hypothesis testing. Discussion of the practical interpretation
of statistical results, along with the difference between statistical significance and practical
significance, is emphasized in the practical examples in the text.

Special Features of the Fifteenth Edition
• NEED TO KNOW. . .: This edition again includes highlighted sections called “NEED

TO KNOW. . .” and identified by this icon.  These sections provide in-
formation consisting of definitions, procedures, or step-by-step hints on problem solv-
ing for specific questions such as “NEED TO KNOW… How to  Construct a Relative
Frequency Histogram?” or “NEED TO KNOW… How to Decide Which Test to Use?”

• Graphical and numerical data description includes both traditional and EDA  methods,
using computer graphics generated by MINITAB 18 for Windows and MS Excel 2016.

• Calculator screen captures from the TI-84 Plus calculator have been used for several
examples, allowing students to access this option for data analysis.
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you wish to use. Many researchers report the smallest possible significance level for 
which their results are statistically significant.

For example, the TI-84 plus output for Example 9.7 (Figure 9.9) shows z 0.90909090915
with 5-value 0.182p . Detailed instructions for the TI-83/84 plus as well as MINITAB can be
found in the Technology Today section at the end of this chapter. These results are consistent
with our hand calculations to the second decimal place. Based on this p-value, H0 cannot 
be rejected. The results are not statistically significant.

Figure 9.9
TI-84 plus output for 
Example 9.7

Sometimes it is easy to confuse the significance level  with the p-value (or observed 
significance level). They are both probabilities calculated as areas in the tails of the sampling
distribution of the test statistic. However, the significance level  is preset by the experi-
menter before collecting the data. The p-value is linked directly to the data and actually
describes how likely or unlikely the sample results are, assuming that H0 is true. The smaller
the p-value, the more unlikely it is that H0 is true!

Rejection Regions, p-Values, and Conclusions
The significance level, a, lets you set the risk that you are willing to take of making 
an incorrect decision in a test of hypothesis.

•	 To set a rejection region, choose a critical value of z so that the area in the 
tail(s) of the z distribution is (are) either  for a one-tailed test or /2a  for a 
two-tailed test. Use the right tail for an upper-tailed test and the left tail for a 
lower-tailed test. Reject H0 when the test statistic exceeds the critical value 
and falls in the rejection region.

•	 To find a p-value, find the area in the tail “beyond” the test statistic. If the 
test is one-tailed, this is the p-value. If the test is two-tailed, this is only half 
the p-value and must be doubled. Reject H0 when the p-value is less than a.

Need to Know…?
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Empirical Rule should work relatively well. That is,

• approximately 68% of the measurements will fall between 16.1

• approximately 95% of the measurements will fall between 10.6

• approximately 99.7% of the measurements will fall between 5.1

Figure 2.11
Relative frequency 
 histogram for Example 2.8

R
el

at
iv

e 
Fr

eq
ue

nc
y

Scores
 8.5 14.5 20.5 26.5 32.5

6/25

4/25

2/25

0

Using Tchebysheff’s Theorem and the Empirical Rule

Tchebysheff’s Theorem gives a lower bound
interval x ks6 . At least k1 (1/ )22
probably more!

distribution).

mate of the fraction of measurements falling within 1, 2, or 3
mean.

Approximating s Using the Range

the calculation of s
measurements lie within two

54428_ch02_hr_054-095.indd   71

42.5 30.0
Ford Escape 41.5 28.0
Hyundai Tucson 41.5 28.0
Jeep Cherokee 43.5 30.0
Jeep Compass 41.5 28.0
Jeep Patriot 41.0 26.0
Kia Sportage 41.5 28.0
Mazda C-5 42.0 27.5
Toyota RAV4 42.0 30.0
Volkswagen Tiguan 42.0 28.0

1. Since the data involve two variables and a third labeling variable, enter the data into
the first three columns of an Excel spreadsheet, using the labels in the table. Select Data 
➤ Data Analysis ➤ Descriptive Statistics, and click OK. Highlight or type the Input 
range (the data in the second and third columns) into the Descriptive Statistics Dialog 
box (Figure 2.19(a)). Type an Output location, make sure the boxes for “Labels in First 
Row” and “Summary Statistics” are both checked, and click OK. The summary statistics
(Figure 2.19(b)) will appear in the selected location in your spreadsheet.

(a) (b)

2. You may notice that some of the cells in the spreadsheet are overlapping. To adjust
this, highlight the affected columns and click the Home tab. In the Cells group,
choose Format ➤ AutoFit Column Width. You may want to modify the appearance
of the output by decreasing the decimal accuracy in certain cells. Highlight the appro-
priate cells and click the Decrease Decimal icon  (Home tab, Number group) to
modify the output. We have displayed the accuracy to three decimal places.

9/24/18   8:37 AM

•	 All examples and exercises in the text that contain printouts or calculator screen 
 captures are based on MINITAB 18, MS Excel 2016, or the TI-84 Plus calculator. 
These outputs are provided for some exercises, while other exercises require the 
student to obtain solutions without using a computer.
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Name Length (km) Name Length (km)

Superior 560 Titicaca 195
Victoria 334 Nicaragua 163
Huron 330 Athabasca 333
Michigan 491 Reindeer 229
Aral Sea 416 Tonle Sap 112
Tanganyika 672 Turkana 246
Baykal 632 Issyk Kul 184
Great Bear 307 Torrens 208
Nyasa 576 Vänern 146
Great Slave 477 Nettilling 107
Erie 386 Winnipegosis 226
Winnipeg 426 Albert 160
Ontario 309 Nipigon 115
Balkhash 602 Gairdner 144
Ladoga 198 Urmia 144
Maracaibo 213 Manitoba 224
Onega 232 Chad 280
Eyre 144

Source: The World Almanac and Book of Facts 2017

a. Use a stem and leaf plot to describe the lengths of 
the world’s major lakes.

b. Use a histogram to display these same data. How 
does this compare to the stem and leaf plot in part a?

c. Are these data symmetric or skewed? If skewed, 
what is the direction of the skewing?

DATA 
SET 

DS0128

6. Gulf oil Spill Cleanup On April 20, 2010, the 
United States experienced a major environmental 
disaster when a Deepwater Horizon drilling rig 

exploded in the Gulf of Mexico. The number of person-
nel and equipment used in the Gulf oil spill cleanup, 
beginning May 2, 2010 (Day 13) through June 9, 2010 
(Day 51) is given in the following table.17

Day 13 Day 26 Day 39 Day 51

Number of personnel (1000s) 3.0 17.5 20.0 24.0
Federal Gulf fishing areas closed 3% 8% 25% 32%
Booms laid (kilometers) 74 504 1030 1454
Dispersants used (1000 liters) 590 1893 3293 4326

d. Use a bar graph to show the percentage of federal 
Gulf fishing areas closed.

e. Use a line chart to show the amounts of dispersants 
used. Is there any underlying straight line relation-
ship over time?

7. election Results The 2016 election was a race 
in which Donald Trump defeated Hillary  Clinton 
and other candidates, winning 304 electoral votes, 

or 57% of the 538 available. However, Trump only won 
46.1% of the popular vote, while Clinton won 48.2%. 
The popular vote (in thousands) for Donald Trump in 
each of the 50 states is listed as follows18:

AL 1319 HI 129 MA 1091 NM 320 SD 228
AK 163 ID 409 MI 2280 NY 2820 TN 1523
AZ 1252 IL 2146 MN 1323 NC 2363 TX 4685
AR 685 IN 1557 MS 701 ND 217 UT 515
CA 4484 IA 801 MO 1595 OH 2841 VT 95
CO 1202 KS 671 MT 279 OK 949 VA 1769
CT 673 KY 1203 NE 496 OR 782 WA 1222
DE 185 LA 1179 NV 512 PA 2971 WV 489
FL 4618 ME 336 NH 346 RI 181 WI 1405
GA 2089 MD 943 NJ 1602 SC 1155 WY 174

a. By just looking at the table, what shape do you think 
the distribution for the popular vote by state will 
have?

b. Draw a relative frequency histogram to describe the 
distribution of the popular vote for President Trump 
in the 50 states.

c. Did the histogram in part b confirm your guess in 
part a? Are there any outliers? How can you explain 
them?

DATA
SET

DS0130

8.  election Results, continued Refer to Exercise 7.
Listed here is the percentage of the popular vote 
received by President Trump in each of the  

50 states18:

62
1

DATA 
SET 

DS0129
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the Role of Computers and Calculators in the  
Fifteenth Edition—technology today
Computers and scientific or graphing calculators are now common tools for college students 
in all disciplines. Most students are accomplished users of word processors, spreadsheets, and 
databases, and they have no trouble navigating through software  packages in the Windows en-
vironment. Many own either a scientific or a graphing calculator, very often one of the many 
calculators made by Texas Instruments.™ We believe, however, that advances in computer 
technology should not turn statistical analyses into a “black box.” Rather, we choose to use 
the computational shortcuts that modern technology provides to give us more time to empha-
size statistical reasoning as well as the understanding and interpretation of statistical results.

In this edition, students will be able to use computers both for standard statistical analy-
ses and as a tool for reinforcing and visualizing statistical concepts. Both MS Excel 2016 and 
MINITAB 18 are used exclusively as the computer packages for statistical analysis along with 
procedures available using the TI-83 or TI-84 Plus calculators. However, we have chosen to 
isolate the instructions for generating computer and calculator output into individual sections 
called Technology Today at the end of each chapter. Each discussion uses numerical examples 
to guide the student through the MS Excel commands and option necessary for the procedures 
presented in that chapter, and then present the equivalent steps and commands needed to pro-
duce the same or similar results using MINITAB and the TI-83/84 Plus. We have included screen 
captures from MS Excel, MINITAB 18, and the TI-84 Plus, so that the student can actually work 
through these sections as “mini-labs.”

If you do not need “hands-on” knowledge of MINITAB, MS Excel, or the TI-83/84 Plus, or if 
you are using another calculator or software package, you may choose to skip these sections and 
simply use the printouts as guides for the basic understanding of computer or calculator outputs.87Technology Today

technOLOgy tOday

Numerical Descriptive measures in Excel
MS Excel provides most of the basic descriptive statistics presented in Chapter 2 using a 
single command on the Data tab. Other descriptive statistics can be calculated using the 
Function Library group on the Formulas tab.

e x a m p l e  2 . 1 7 The following data are the front and rear leg rooms (in inches) for 10 different compact sports 
utility vehicles13:

Make & Model Front Leg Room Rear Leg Room

Chevrolet Equinox 42.5 30.0
Ford Escape 41.5 28.0
Hyundai Tucson 41.5 28.0
Jeep Cherokee 43.5 30.0
Jeep Compass 41.5 28.0
Jeep Patriot 41.0 26.0
Kia Sportage 41.5 28.0
Mazda C-5 42.0 27.5
Toyota RAV4 42.0 30.0
Volkswagen Tiguan 42.0 28.0

1. Since the data involve two variables and a third labeling variable, enter the data into
the first three columns of an Excel spreadsheet, using the labels in the table. Select Data 
➤ Data Analysis ➤ Descriptive Statistics, and click OK. Highlight or type the Input 
range (the data in the second and third columns) into the Descriptive Statistics Dialog 
box (Figure 2.19(a)). Type an Output location, make sure the boxes for “Labels in First 
Row” and “Summary Statistics” are both checked, and click OK. The summary statistics
(Figure 2.19(b)) will appear in the selected location in your spreadsheet.

Figure 2.19 (a) (b)

2. You may notice that some of the cells in the spreadsheet are overlapping. To adjust
this, highlight the affected columns and click the Home tab. In the Cells group,
choose Format ➤ AutoFit Column Width. You may want to modify the appearance
of the output by decreasing the decimal accuracy in certain cells. Highlight the appro-
priate cells and click the Decrease Decimal icon  (Home tab, Number group) to
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3. Notice that the sample quartiles, Q1 and Q3, are not given in the Excel output in
Figure 2.19(b). You can calculate the quartiles using the function command. Place your 
cursor into an empty cell and select Formulas ➤ More Functions ➤ Statistical ➤
QUARTILE.EXC. Highlight the appropriate cells in the box marked “Array” and type 
an integer ( 50 min, 51 first quartile, 52 median, 53 third quartile, or 54 max) in the 
box marked “Quart.” The quartile (calculated using this textbook’s method) will appear 
in the cell you have chosen. Using the two quartiles, you can calculate the IQR and
construct a box plot by hand.

Numerical Descriptive measures in MINITAB
MINITAB provides most of the basic descriptive statistics presented in Chapter 2 using a 
single command in the drop-down menus.

e x a m p l e  2 . 1 8 The following data are the front and rear leg rooms (in inches) for 10 different compact sports
utility vehicles13:

Make & Model Front Leg Room Rear Leg Room

Chevrolet Equinox 42.5 30.0
Ford Escape 41.5 28.0
Hyundai Tucson 41.5 28.0
Jeep Cherokee 43.5 30.0
Jeep Compass 41.5 28.0
Jeep Patriot 41.0 26.0
Kia Sportage 41.5 28.0
Mazda C-5 42.0 27.5
Toyota RAV4 42.0 30.0
Volkswagen Tiguan 42.0 28.0

1. Since the data involve two variables and a third labeling variable, enter the data into
the first three columns of a MINITAB worksheet, using the labels in the table. Using the 
drop-down menus, select Stat ➤ Basic Statistics ➤ Display Descriptive Statistics. The
Dialog box is shown in Figure 2.20(a).

Figure 2.20

89Technology Today

2. Now click on the Variables box and select both columns from the list on the left. (You can
click on the Graphs option and choose one of several graphs if you like. You may also click
on the Statistics option to select the statistics you would like to see displayed.) Click OK. 
A display of descriptive statistics for both columns will appear in the Session window (see
Figure 2.20(b)). You may print this output using File ➤ Print Session Window if you choose.

3. To examine the distribution of the two variables and look for outliers, you can create box
plots using the command Graph ➤ Boxplot ➤ One Y ➤ Simple. Click OK. Select the 
appropriate column of measurements in the Dialog box (see Figure 2.21(a)). You can
change the appearance of the box plot in several ways. Scale ➤ Axes and Ticks will 
allow you to transpose the axes and orient the box plot horizontally, when you check the 
box marked “Transpose value and category scales.” Multiple Graphs provides printing 
options for multiple box plots. Labels will let you annotate the graph with titles and
footnotes. If you have entered data into the worksheet as a frequency distribution (values
in one column, frequencies in another), the Data Options will allow the data to be read 
in that format. The box plot for the front leg rooms is shown in Figure 2.21(b).

4. Save this worksheet in a file called “Leg Room” before exiting MINITAB. We will use it 
again in Chapter 3.

(b)(a)

Figure 2.21

Numerical Descriptive measures on the TI-83/84 Plus Calculators
The TI-83/84 Plus calculators can be used to calculate descriptive statistics and create box 
plots using the stat ➤ CALC and 2nd ➤ stat plot commands.

e x a m p l e  2 . 1 9 The following data are the front and rear leg rooms (in inches) for 10 different compact sports
utility vehicles13:

Make & Model Front Leg Room Rear Leg Room

Chevrolet Equinox 42.5 30.0
Ford Escape 41.5 28.0
Hyundai Tucson 41.5 28.0

Jeep Compass 41.5 28.0Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.
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Study aids
The many and varied exercises in the text provide the best learning tool for students em-
barking on a first course in statistics. The answers to all odd-numbered exercises are given 
in the back of the text. Each application exercise has a title, making it easier for students 
and instructors to immediately identify both the context of the problem and the area of 
application. All of the basic exercises have been rewritten and all of the applied exercises 
restructured according to  increasing difficulty. New exercises have been introduced, dated 
exercises have been deleted, and a new numbering system has been introduced within each 
section.

The probability of observing 211 or fewer who prefer her brand is

P x p p p p( 211) (0) (1) ... (210) (211)# 5 1 1 1 1

The normal approximation to this probability is the area to the left of 211.5 under a normal 
curve with a mean of 250 and a standard deviation of 15. First calculate

211.5 250

15
2.57z

x m

s
5

2
5

2
5 2

Then

( 211) ( 2.57) .0051P x P z 2 5≤ ≈ <

The probability of observing a sample value of 211 or less when .10p 5  is so small that you 
can conclude that one of two things has occurred: Either you have observed an unusual sample 
even though really .10p 5 , or the sample reflects that the actual value of p is less than .10 and 
perhaps closer to the observed sample proportion, 5211/2500 .08.

the basics
Normal Approximation? Can the normal approxima-
tion be used to approximate probabilities for the bino-
mial random variable x, with values for n and p given 
in Exercises 1–4? If not, is there another approximation 
that you could use?

1. 25n 5  and .6p 5  2. 45n 5  and .05p 5

3. 25n 5  and .3p 5  4. 15n 5  and .5p 5

Using the Normal Approximation Find the mean and 
standard deviation for the binomial random variable x 
using the information in Exercises 5–11. Then use the 
correction for continuity and approximate the probabili-
ties using the normal approximation.

5. P x( 9).  when 25n 5  and .6p 5

6. P x(6 9)# #  when 25n 5  and .3p 5

7. P x(20 25), ,  when 100n 5  and .2p 5

8. P x( 22).  when 100n 5  and .2p 5

9. P x( 22)$  when 100n 5  and .2p 5

10. P x( 25)#  when 100n 5  and .2p 5

11. P x(355 360)# #  when 400n 5  and .9p 5

How Good Is Your Approximation? Using Table 1 in 
Appendix I, find the exact values for the binomial prob-
abilities in Exercises 12–15. Then approximate the 
probabilities using the normal approximation with the 
correction for continuity. Compare your answers.

12. P x( 6)$  and P x( 6).  when 15n 5  and .5p 5

13. P x(4 6)# #  when 25n 5  and .2p 5

14. P x( 7)$  and ( 5)P x 5  when 20n 5  and .3p 5

15. P x( 10)$  when 20n 5  and .4p 5

applying the basics
16. A USA Today snapshot found that 47% of Ameri-
cans associate “recycling” with Earth Day.9 Suppose a 
random sample of 50n 5  adults are polled and that the 
47% figure is correct. Use the normal curve to approxi-
mate the probabilities of the following events.

Cleaning
local parks,
beaches,etc.

Taking care
of the Earth

What do you relate most to Earth Day?

Recycling

Planting a tree

47%

30%

23%

a. Fewer than 30 individuals associate “recycling” with 
Earth Day?

b. More than 20 individuals associate “recycling” with 
Earth Day?

c. More than 10 individuals do not associate 
 “recycling” with Earth Day?

6.3 exercises

54428_ch06_hr_212-244.indd   232

Students should be encouraged to use the “NEED TO KNOW. . .” sections as they 
occur in the text. The placement of these sections is intended to answer questions as they 
would normally arise in discussions. In addition, there are numerous hints called “NEED 
A TIP?” that appear in the margins of the text. The tips are short and concise.

chapter 7 Sampling Distributions246

introduction
In the previous three chapters, you have learned a lot about probability distributions, such 
as the binomial and normal distributions. The shape of the normal distribution is determined 
by its mean m and its standard deviation s, while the shape of the binomial distribution is 
determined by p. These numerical descriptive measures—called parameters—are needed 
to calculate the probability of observing sample results.

In practical situations, you may be able to decide which type of probability distribution 
to use as a model, but the values of the parameters that specify its exact form are unknown. 
Here are two examples:

•	 The person conducting an opinion poll is sure that the responses to his “agree/dis-
agree” questions will follow a binomial distribution, but p, the proportion of those 
who “agree” in the population, is unknown.

•	 An agricultural researcher believes that the yield per acre of a variety of wheat is 
approximately normally distributed, but the mean m and standard deviation s  of the 
yields are unknown.

In these cases, you must rely on the sample to learn about these parameters. The proportion of 
those who “agree” in the pollster’s sample provides information about the actual value of p. 
The mean and standard deviation of the researcher’s sample approximate the actual values of 
m and s . If you want the sample to provide reliable information about the population, however, 
you must select your sample in a certain way!

 7.1 Sampling plans and experimental Designs
The way a sample is selected is called the sampling plan or experimental design. Know-
ing the sampling plan used in a particular situation will often allow you to measure the 
reliability or goodness of your inference.

Simple random sampling is a commonly used sampling plan in which every sample 
of size n has the same chance of being selected. For example, suppose you want to select 
a sample of size 2n 5  from a population containing 4N 5  objects. If the four objects are 
identified by the symbols 1x , 2x , 3x , and 4x , there are six distinct pairs that could be selected, 
as listed in Table 7.1. If the sample of 2n 5  observations is selected so that each of these 
six samples has the same chance—one out of six or 1/6—of selection, then the resulting 
sample is called a simple random sample, or just a random sample.

●●  Need a Tip?
parameter ⇔ population
Statistic ⇔ Sample

Finally, sections called Key Concepts and Formulas appear in each chapter as a review 
in outline form of the material covered in that chapter.
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26. Snapshots Here are a few snapshots from USA 
Today.

• About 12% of America’s volunteers spend more than 
5 hours per week volunteering.

• Fifty-eight percent of all cars in operation are at least 
8 years old.

• Twenty-two percent of all fans are willing to pay 
$75 or more for a ticket to one of the top 100 concert 
tours.

Identify the variable x being measured, and any 
 percentiles you can determine from this information.

Key Concepts and Formulas

I. Measures of the Center of a Data Distribution
1. Arithmetic mean (mean) or average

a. Population: m

b. Sample of n measurements: x
x

n
i5

∑

2. Median; nposition 5 of the median .5( 1)

3. Mode

4. The median may be preferred to the mean if the 
data are highly skewed.

II. Measures of Variability
1. Range: R 5 2largest smallest

2. Variance

a. Population of N measurements:

 
x

N
is

m
5

2( )2
2∑

b. Sample of n measurements:

i2

2. The Empirical Rule can be used only for rela-
tively mound-shaped data sets. Approximately 
68%, 95%, and 99.7% of the measurements are 
within one, two, and three standard deviations of 
the mean, respectively.

IV. Measures of Relative Standing

1. Sample z-score: z
x x

s
5

2

2. pth percentile; p% of the measurements are 
smaller, and p2(100 )% are larger.

3. Lower quartile, Q1; position of Q n5 .25 ( 1)1

4. Upper quartile, Q3; position of Q n5 .75 ( 1)3

5. Interquartile range: Q Q5 2IQR 3 1

V. The Five-Number Summary and Box Plots
1. The five-number summary:

 Q QMin Median Max1 3

 One-fourth of the measurements in the data set 
lie between each of the four adjacent pairs of 
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Instructor Resources

Webassign
WebAssign for Mendenhall/Beaver/Beaver’s Introduction to Probability and Statistics, 15th 
Edition, Metric Version is a flexible and fully customizable online instructional solution 
that puts powerful tools in the hands of instructors, empowering you to deploy assignments, 
 instantly assess individual student and class performance, and help your students master the 
course concepts. With WebAssign’s powerful digital platform and Introduction to Probability 
and Statistics’s specific content, you can tailor your course with a wide range of assignment 
settings, add your own questions and content, and access student and course analytics and 
communication tools.

Mindtap Reader
Available via WebAssign, MindTap Reader is Cengage’s next-generation eBook. MindTap 
Reader provides robust opportunities for students to annotate, take notes, navigate, and 
interact with the text. Instructors can edit the text and assets in the Reader, as well as add 
videos or URLs.

Cognero
Cengage Learning Testing, powered by Cognero, is a flexible, online system that allows 
you to import, edit, and manipulate content from the text’s Test Bank or elsewhere— 
including your own favorite test questions; create multiple test versions in an instant; and 
deliver tests from your LMS, your classroom, or wherever you want.

Instructor Solutions Manual
This time-saving online manual provides complete solutions to all the problems in the text. 
You can download the solutions manual from the Instructor Companion Website.

Instructor Companion Website
Everything you need for your course in one place! This collection of book-specific class 
tools is available online via www.cengage.com/login. Access and download PowerPoint 
presentations, images, Instructor Solutions Manual, data sets, and more.

SnapStat
Tell the story behind the numbers with SnapStat in WebAssign. Designed with students 
to bring stats to life, SnapStat uses interactive visuals to perform complex analysis online. 
Labs and Projects in WebAssign allow students to crunch their own data or choose from 
pre-existing data sets to get hands-on with technology and see for themselves that Statistics 
is much more than just numbers.

Student Resources

Webassign
WebAssign for Mendenhall/Beaver/Beaver’s Introduction to Probability and Statistics, 
15th Edition, Metric Version lets you prepare for class with confidence. Its online learning 
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platform for your math, statistics, and science courses helps you practice and absorb what 
you learn. Videos and tutorials walk you through concepts when you’re stuck, and instant 
feedback and grading let you know where you stand—so you can focus your study time 
and perform better on in-class assignments. Study smarter with WebAssign!

Mindtap Reader
Available via WebAssign, MindTap Reader is Cengage’s next-generation eBook.  MindTap 
Reader provides robust opportunities for students to annotate, take notes, navigate, and 
 interact with the text. Annotations captured in MindTap are automatically tied to the 
 Notepad app, where they can be viewed chronologically and in a cogent, linear fashion.

online technology Guides
Online Technology Guides, accessed via www.cengage.com, provide step-by-step  instructions 
for completing problems using common statistical software.

SnapStat
Learn the story behind the numbers with SnapStat in WebAssign. Designed with students 
to bring stats to life, SnapStat uses interactive visuals to perform complex analysis online. 
Labs and Projects in WebAssign allow you to crunch your own data or choose from pre-
existing data sets to get hands-on with technology and see for yourself that Statistics is 
much more than just numbers.
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Introduction 
What Is  Statistics?

What is statistics? Have you ever met a statistician? Do 
you know what a statistician does? Maybe you are think-
ing of the person who sits in the broadcast booth at the 
Rose Bowl, recording the number of pass completions, 
yards rushing, or interceptions thrown on New Year’s Day. 
Or maybe just hearing the word statistics sends a shiver of 
fear through you. You might think you know nothing about 
statistics, but almost every time you turn on the news or 
scroll through your favorite news app, you will find statis-
tics in one form or other! Here are some examples that we 
found just before the 2017 November elections:

Andrea Ricordi, Italy/Moment/Getty Images

• Northam Heads Into Virginia Governor’s Race With A Small Lead. The first
major statewide elections since President Trump was inaugurated take place on
Tuesday…And while the race’s final result by itself isn’t likely to tell us much
about the national political environment, it is likely to have a big effect on the 2018
midterms. Polls show a fairly close race, with Northam slightly favored to win [over
Ed Gillespie]. An average of the last 10 surveys give Northam a 46 percent-to-43
percent advantage. Over the past month, there has been a tightening of the race, with
Gillespie closing what had been a 6-point lead. In the individual polls, though, there
is a fairly wide spread. Northam has led by as much as 17 percentage points
(a Quinnipiac University survey) and has trailed by as much as 8 points (a Hampton
University poll).1

—www.fivethirtyeight.com

• Why Trump Has a Lock on the 2020 GOP  Nomination. In interviews with nearly
three-dozen GOP strategists and fundraisers over the past several tumultuous weeks,
virtually everyone told me that…they expect Trump to coast to the GOP nomina-
tion in 2020…the hurdles to a 2020 primary challenge are vivid when considering
a recent Washington Post/ABC News poll that found 91% of Trump voters said
they’d vote for him again…This ABC News/Washington Post poll was conducted by
landline and cellular telephone Oct. 29-Nov. 1, 2017, in English and Spanish, among
a random national sample of 1005 adults. Results have a margin of sampling error of
3.5 points, including the design effect.2

—www.cnn.com
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Articles similar to these can be found in all forms of news media, and, just before a presi-
dential or congressional election, a new poll is reported almost every day. These articles are 
very familiar to us; however, they might leave you with some unanswered questions. How 
were the people in the poll selected? Will these people give the same response tomorrow? 
Will they give the same response on election day? Will they even vote? Are these people 
representative of all those who will vote on election day? It is the job of a statistician to ask 
these questions and to find answers for them in the language of the poll.

Most Believe “Cover-Up” of JFK Assassination Facts
A majority of the public believes the assassination of President John F. Kennedy was part of a 
larger conspiracy, not the act of one individual. In addition, most Americans think there was a 
cover-up of facts about the 1963 shooting. Almost 50 years after JFK’s assassination, a FOX 
news poll shows many Americans disagree with the government’s conclusions about the killing. 
The Warren Commission found that Lee Harvey Oswald acted alone when he shot Kennedy, 
but 66 percent of the public today think the assassination was “part of a larger conspiracy” while 
only 25 percent think it was the “act of one individual.”

“For older Americans, the Kennedy assassination was a traumatic experience that began 
a loss of confidence in government,” commented Opinion Dynamics President John Gorman. 
“Younger people have grown up with movies and documentaries that have pretty much pushed 
the ‘conspiracy’ line. Therefore, it isn’t surprising there is a fairly solid national consensus that 
we still don’t know the truth.”

(The poll asked): “Do you think that we know all the facts about the assassination of 
 President John F. Kennedy or do you think there was a cover-up?”

We Know All the Facts (%) There Was a Cover-Up (Not Sure)

All 14 74 12
Democrats 11 81  8
Republicans 18 69 13
Independents 12 71 17

 —www.foxnews.com3

When you see an article like this one, do you simply read the title and the first paragraph, 
or do you read further and try to understand the meaning of the numbers? How did the 
authors get these numbers? Did they really interview every American with each political 
affiliation? It is the job of the statistician to answer some of these questions.

Hot News: 98.68F Not Normal
After believing for more than a century that 98.6°F was the normal body temperature for 
humans, researchers now say normal is not normal anymore.

For some people at some hours of the day, 99.9°F could be fine. And readings as low as 
96°F turn out to be highly human.

The 98.6°F standard was derived by a German doctor in 1868. Some physicians have always 
been suspicious of the good doctor’s research. His claim: 1 million readings—in an epoch 
without computers.

So Mackowiak & Co. took temperature readings from 148 healthy people over a three-day 
period and found that the mean temperature was 98.2°F. Only 8 percent of the readings were 
98.6°F.

—The Press-Enterprise4

What questions do you have when you read this article? How did the researcher select the 
148 people, and how can we be sure that the results based on these 148 people are accurate 
when applied to the general population? How did the researcher arrive at the normal “high” 
and “low” temperatures given in the article? How did the German doctor record 1 million 
temperatures in 1868? This is another statistical problem with an application to everyday life.

Statistics is a branch of mathematics that has applications in almost every part of our 
daily life. It is a new and unfamiliar language for most people, however, and, like any 
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new language, statistics can seem overwhelming at first glance. But once the language of 
statistics is learned and understood, it provides a powerful tool for data analysis in many 
different fields of application.

  The Population and the Sample
In the language of statistics, one of the most basic concepts is sampling. In most statistical 
problems, a specified number of measurements or data—a sample—is drawn from a much 
larger body of measurements, called the population.

Population

Sample

For the body-temperature experiment, the sample is the set of body-temperature mea-
surements for the 148 healthy people chosen by the experimenter. We hope that the sample 
is representative of a much larger body of measurements—the population—the body tem-
peratures of all healthy people in the world!

Which is more important to us, the sample or the population? In most cases, we are 
interested primarily in the population, but identifying each member of the population may 
be difficult or impossible. Imagine trying to record the body temperature of every healthy 
person on earth or the presidential preference of every registered voter in the United States! 
Instead, we try to describe or predict the behavior of the population on the basis of 
information obtained from a representative sample from that population.

The words sample and population have two meanings for most people. For example, 
you read that a Gallup poll conducted in the United States was based on a sample of  
1823 people. Presumably, each person interviewed is asked a particular question, and that 
person’s response represents a single measurement in the sample. Is the sample the set of 
1823 people, or is it the 1823 responses that they give?

In statistics, we distinguish between the set of objects on which the measurements are 
taken and the measurements themselves. To experimenters, the objects on which measure-
ments are taken are called experimental units. The sample survey statistician calls them 
elements of the sample.

  Descriptive and Inferential Statistics
When first presented with a set of measurements—whether a sample or a population—you 
need to find a way to organize and summarize it. The branch of statistics that gives us tools 
for describing sets of measurements is called descriptive statistics. You have seen descrip-
tive statistics in many forms: bar charts, pie charts, and line charts presented by a political 
candidate; numerical tables in the media; or the average rainfall amounts on your favorite 
weather app. Computer-generated graphics and numerical summaries are commonplace in 
our everyday communication.
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Definition

Descriptive statistics are procedures used to summarize and describe the important 
characteristics of a set of measurements.

Definition

Inferential statistics are procedures used to make inferences (that is, draw conclusions, 
make predictions, make decisions) about a population from information contained in a 
sample drawn from this population.

If the set of measurements is the entire population, you need only to draw conclusions 
based on the descriptive statistics. However, it might be too expensive or too time consum-
ing to identify each member of the population. Maybe listing the entire population would 
destroy it—for example, measuring the amount of force required to cause a football helmet 
crack. For these or other reasons, you may have only a sample from the population. By 
looking at the sample, you want to answer questions about the population as a whole. The 
branch of statistics that deals with this problem is called inferential statistics.

The objective of inferential statistics is to make inferences about a population from 
information contained in a sample.

Achieving the Objective of Inferential 
Statistics: The Necessary Steps
How can you make inferences about a population using information contained in a sample? 
The task becomes simpler if you organize the problem into a series of logical steps.

1.  Specify the questions to be answered and identify the population of interest. In
the Virginia election poll, the objective is to determine who will get the most votes
on election day. So, the population of interest is the set of all votes in the Virginia
election. When you select a sample, it is important that the sample be representative
of this population, not the population of voter preferences on some day prior to
the election.

2.  Decide how to select the sample. This is called the design of the experiment or the
sampling procedure. Is the sample representative of the population of interest? For
example, if a sample of registered voters is selected from the city of San Francisco,
will this sample be representative of all voters in California? Will it be the same as
a sample of “likely voters”—those who are likely to actually vote in the election?
Is the sample large enough to answer the questions posed in step 1 without wasting
time and money on additional information? A good sampling design will answer
the questions posed with minimal cost to the experimenter.

3.  Select the sample and analyze the sample information. No matter how much
information the sample contains, you must use an appropriate method of analysis to
obtain it. Many of these methods, which depend on the sampling procedure in
step 2, are explained in the text.
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4.  Use the information from step 3 to make an inference about the population.
Many different procedures can be used to make this inference, and some are bet-
ter than others. For example, 10 different methods might be available to estimate
human response to an experimental drug, but one procedure might be more accurate
than others. You should use the best inference-making procedure available (many of
these are explained in the text).

5.  Determine the reliability of the inference. Since you are using only a fraction of
the population in drawing the conclusions described in step 4, you might be wrong!
If an agency conducts a statistical survey for you and estimates that your company’s
product will gain 34% of the market this year, how much confidence can you place
in this estimate? Is this estimate accurate to within 1, 5, or 20 percentage points? Is
it reliable enough to be used in setting production goals? Every statistical inference
should include a measure of reliability that tells you how much confidence you
have in the inference.

Now that you have learned a few basic terms and concepts, we again pose the ques-
tion asked at the beginning of this discussion: Do you know what a statistician does? The 
 statistician’s job is to carry out all of the preceding steps.

Keys for Successful Learning
As you begin to study statistics, you will find that there are many new terms and concepts 
to be mastered. Since statistics is an applied branch of mathematics, many of these basic 
concepts are mathematical—developed and based on results from calculus or higher math-
ematics. However, you do not have to be able to prove the results in order to apply them 
in a logical way. In this text, we use numerical examples and commonsense arguments to 
explain statistical concepts, rather than more complicated mathematical arguments.

Computers and calculators are now readily available to many students and provide 
them with an invaluable tool. In the study of statistics, even the beginning student can 
use packaged programs to perform statistical analyses with a high degree of speed and 
 accuracy. Some of the more common statistical packages available at computer facilities 
are  MINITABTM, SAS, and SPSS. Personal computers and laptops will support MINITAB, 
MS EXCEL, JMP, and others. Many students are familiar with the TI-83 or TI-84 Plus cal-
culators, that have many built-in statistics functions. There are even online statistical pro-
grams and interactive “applets” that students can use.

These programs, called statistical software, differ in the types of analyses available, 
the options within the programs, and the forms of printed results (called output). However, 
they are all similar. In this book, we use both MINITAB and Microsoft Excel as statistical tools. 
Understanding the basic output of these packages will help you interpret the output from 
other software systems. Similarly, understanding the results shown on your TI-83 or TI-84 
Plus calculator will make understanding a different calculator much easier.

At the end of most chapters, you will find a section called “Technology Today.” These 
sections present numerical examples to guide you through the MINITAB, MS Excel, and  
TI-83/84 Plus commands and options that are used for the procedures in that chapter. If 
you are using MINITAB, MS Excel, or your TI-83/84 Plus calculator in a lab or home setting, 
you may want to work through this section using your own computer or calculator so that 
you become familiar with the hands-on methods. If you do not need hands-on knowl-
edge of MINITAB, MS Excel, or the TI-83/84 Plus, you may choose to skip this  section 
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and  simply use the computer printouts or calculator screen captures for analysis as they 
appear in the text.

Most important, using statistics successfully requires common sense and logical think-
ing. For example, if we want to find the average height of all students at a particular uni-
versity, would we select our entire sample from the members of the basketball team? In the 
body-temperature example, the logical thinker would question an 1868 average based on  
1 million measurements—when computers had not yet been invented.

As you learn new statistical terms, concepts, and techniques, remember to view every 
problem with a critical eye and be sure that the rule of common sense applies. Throughout 
the text, we will remind you of the pitfalls and dangers in the use or misuse of statistics. 
Benjamin Disraeli once said that there are three kinds of lies: lies, damn lies, and statistics! 
Our purpose is to prove this claim to be wrong—to show you how to make statistics work 
for you and not lie for you!

As you continue through the book, refer back to this introduction every once in a while. 
Each chapter will increase your knowledge of statistics and should, in some way, help you 
achieve one of the steps described here. Each of these steps is important in achieving the 
overall objective of inferential statistics: to make inferences about a population using infor-
mation contained in a sample drawn from that population.
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Describing Data  
with Graphs

LearninG Objectives
Many sets of measurements are samples selected from larger populations. Other sets constitute 
the entire population, as in a national census. In this chapter, you will learn what a variable is, 
how to classify variables into several types, and how measurements or data are generated. You 
will then learn how to use graphs to describe data sets.

chapter inDex
●● Data distributions and their shapes (1.1, 1.3)

●● Dotplots (1.3)

●● Pie charts, bar charts, line charts (1.2, 1.3)

●● Qualitative and quantitative variables—discrete and continuous (1.1)

●● Relative frequency histograms (1.4)

●● Stem and leaf plots (1.3)

●● Univariate and bivariate data (1.1)

●● Variables, experimental units, samples and populations, data (1.1)

●● Need to Know…
How to Construct a Stem and Leaf Plot

How to Construct a Relative Frequency Histogram

1

© Photographee.eu/Shutterstock.com

how is Your blood pressure?
Is your blood pressure normal, or is it too high or too low? 
The case study at the end of this chapter examines a large 
set of blood pressure data. You will use graphs to describe 
these data and compare your blood pressure with that of 
others of your same age and gender.
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 1.1 variables and Data
In Chapters 1 and 2, we will present some basic techniques in descriptive statistics—the 
branch of statistics concerned with describing sets of measurements, both samples and 
populations. Once you have collected a set of measurements, how can you display this set 
in a clear, understandable, and readable form? First, you must be able to define what is 
meant by measurements or “data” and to categorize the types of data that you are likely to 
encounter in real life. We begin by introducing some definitions.

DefiNitioN

A variable is a characteristic that changes or varies over time and/or for different 
 individuals or objects under consideration.

DefiNitioN

A population is the set of all measurements of interest to the investigator.

DefiNitioN

A sample is a subset of measurements selected from the population of interest.

For example, body temperature is a variable that changes over time within a single indi-
vidual; it also varies from person to person. Religious affiliation, ethnic origin, income, 
height, age, and number of offspring are all variables—characteristics that vary depending 
on the individual chosen.

In the Introduction, we defined an experimental unit or an element of the sample as the 
object on which a measurement is taken. This is the same as saying that an experimental 
unit is the object on which a variable is measured. When a variable is actually measured on 
a set of experimental units, a set of measurements or data result.

DefiNitioN

An experimental unit is the individual or object on which a variable is measured.  
A single measurement or data value results when a variable is actually measured on 
an experimental unit.

If a measurement is obtained for every experimental unit in the entire collection, the  resulting 
data set constitutes the population of interest. Any smaller subset of  measurements is a sample.

e x a m p l e  1 . 1 A set of five students is selected from all undergraduates at a large university, and  measurements 
are entered into a spreadsheet as shown in Figure 1.1. Identify the various elements involved 
in obtaining this set of measurements.

solution  The experimental unit on which the variables are measured is a particular under-
graduate student on the campus, found in column A. Five variables are measured for each 
student: grade point average (GPA), gender, year in college, major, and current number of units 
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There is a difference between a single variable measured on a single experimental unit 
and multiple variables measured on a single experimental unit as in Example 1.1.

DefiNitioN

Univariate data results when a single variable is measured on a single experimental unit.

DefiNitioN

Bivariate data results when two variables are measured on a single experimental unit. 
Multivariate data results when more than two variables are measured.

If you measure the body temperatures of 148 people, the resulting data are univariate. In 
Example 1.1, five variables were measured on each student, resulting in multivariate data.

■ types of variables
Variables can be classified into one of two types: qualitative or quantitative.

DefiNitioN

Qualitative variables measure a quality or characteristic on each experimental unit. 
 Quantitative variables measure a numerical quantity or amount on each experimental unit.

enrolled. Each of these characteristics varies from student to student. If we consider the GPAs 
of all students at this university to be the population of interest, the five GPAs in column B rep-
resent a sample from this population. If the GPA of each undergraduate student at the university 
had been measured, we would have the entire population of measurements for this variable.

The second variable measured on the students is gender, in column C. This variable is 
somewhat different from GPA, because it typically takes one of two values—male (M) or 
female (F). If we could identify each member of the population, it would consist of a set 
of Ms and Fs, one for each student at the university. The third and fourth variables, year 
and major, also involve nonnumerical data—year has four categories (Fr, So, Jr, Sr), and 
major has one category for each undergraduate major on campus. The last variable, current 
number of units enrolled, is numerically valued, consisting of a set of numbers rather than 
a set of qualities or characteristics.

Although we have discussed each variable individually, remember that we have measured 
each of these five variables on a single experimental unit: the student. Therefore, in this 
example, a “measurement” really consists of five observations, one for each of the five mea-
sured variables. For example, the measurement taken on student 2 produces this observation:

(2.3, F, So, Mathematics, 15)

Figure 1.1
Measurements on five 
undergraduate students




